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Getting Started: Worksheet Basics

ABOUT WORKSHEETS

Worksheets enable ad hoc data exploration, analysis, visualization,
and collaboration with live transactional data within a secure Workday
environment.

ACCESS WORKSHEETS
The best way to access Worksheets is from Drive.
1. Click the worker profile icon.

2. From the menu, select Drive.

L 2 @
g Logan McNeil
View Profile
| ‘m Home
£ Workbench
B sitemap
j:r Favorites
E Aud
[ Drive
Y MyReports
? Documentation 4]
E Help 2
8 My Account >
GExD

This is where your files, including worksheets, are stored.
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<]] Important: Because workbooks are stored in Drive, a user
needs access to both the Drive security domain and
Worksheets domain.

CREATE WORKBOOKS

There are two ways to create a workbook: as a new, blank workbook,
or uploaded from an existing external file, like an Excel sheet.

CREATE A NEW BLANK WORKBOOK
1. Within Drive, click Add New.
2. Select Workbook.

ﬁ O Search

=D

& Upload

[ Folder

'ﬁ': Discovery Board

Workbook

3. Rename the workbook as desired.

Your screens and processes may vary from this document. Confidential ©2020 Workday, Inc. 1
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UPLOAD A WORKBOOK FROM AN EXTERNAL FILE EXPORT WORKBOOKS
1. Within Drive, click Add New. Workbooks can be exported from a Report Writer report. These
2. Select Upload. exports are not live data, but a snapshot of the data at the time of
export.
ﬁ Q search 1. From the Home page, search for and select the My Team Time

Off Balances report.

2. To begin the export process, click the Export to Worksheets
icon.

& Upload : . R
My Team's Time Off Balances Ciions)
[ Folder
9 items 53 E ila 7
o ol
11y Discovery Board Al Eligible Time Off Plans for Worker
Workbook Worker T"-'TD
Tirme Off Plan Unit of Time Balance |g|;
Taken

3. Navigate back to Drive to view the exported report.

Search Results 1 item

3. Select a file and click Open.

You will see two versions of your file: one in the original format and

Name Location

the other converted into a worksheet. = e iy Teams T 1 B s
fif  Trash

W e a

All Files - o

[ AuFiles Heze Qwner Access Last Modified

o e || ST IMPORT LIVE DATA

- Live Workday data can be imported into your workbook using the

_~‘ ' ’¢_ Hint: You also have the option to drag files from your guided editor.

'@~ computer directly into the All Files list to upload. 1. From the workbook, add a new sheet by clicking the plus sign in

the bottom-left corner.

Your screens and processes may vary from this document. Confidential ©2020 Workday, Inc. 2
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Workbook

File Edit View Format

<

& A  Aral - 10

Al fx
4 A B

L1

~N e W N =

Sheet1 -

Name the sheet.

Select the A1 cell in the worksheet.

Click the Add Live Data button or click Data > Add Live Data.

~
W Qe ? e @
e workbOOk E e
File Edit View Format Insert Data Help All changes are saved automatically
dadiad i R B bt r A SR, : L
A
L Refresh All Live Data  \F ui}
A B c F G H | J K L
1 : Schedule Live Data Refresh
2
3 Define Name
4
5 Protect Range

A guided editor opens. On the left side, locate the Report Writer
report you want to open from the list of reports, or use the search
field. You can also select the Include reports not enabled for
Worksheets checkbox in the bottom-left corner to view all
available report options.

N\
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Select Report

Q) Search for reports

Active Candidates by Stage

Al GMS - Assets by Category

Al GMS - Current Workers

Al GMS - Drillback for Expense
Al GMS - Drillback for Expense by Spend
Category

Al GMS - Drillback for Revenue

Al GMS - Drillback for Revenue by Select a Report on the Left

Category

Al GMS - Drillback to Journal Lines

Note: Reports must be enabled to export them for
Worksheets. To enable, select Enable As Web Service
and Enable for Worksheets in the Advanced tab of the
Report Writer report. To learn more about working with
live data, see the Worksheets Learn Independent course
in the Workday Learning Center.

Once you have selected a report, click Next.

Depending on the report selected, you may be required to enter
any prompt values set up on that report.

Once your report has loaded, the available columns will populate
on the left side.

Select the columns for the report by either selecting the plus icon,
dragging and dropping each column, or clicking Select All to
transfer all columns at once.

Your screens and processes may vary from this document. Confidential ©2020 Workday, Inc. 3
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Select Columns Benefits Modeling X Select Options Benefits Modeling
Q@ search by column name 5 Columns Added Remove All Preview a sample of data @ Insert report data as:
O LiveData Area Static Values
Available Columns L B croioyee X | BenefitGroup X | BenefitProvider X | BenefitPlan X | Coverage X Maintain a connection to Workday data. You Does not maintain 2 connection to Workdsy
«can refresh the contents of a live data area on data. A snapshot of the report data will be
+  Supervisory Organization demand inserted as static values.
+  Benefit Plan : Coverage
Limit number of rows inserted
+  Marital Status
B Highlight live data area
+  Age Group
Allow only the owner to refresh live data (for all live data in the workbook)
+  #of Dependents
Enable Mult-instance Values
+  Employee Cost Manthly in ...
+  Employer Cost Monthly in ..

15 At Cokenn 13. Select Live Data.

e 14. Click Add. Your workbook with live data automatically opens

within Drive.

#x Add Formula Column I order By (1)

10. To populate column data as it will appear in your Worksheet, ~ Viorboox ERE ...
SeleCt the PreVIeW a sam ple of data toggle File Edit View Format Insert Data Help All changes are saved automatically
: S A Adel * 10+ B I U Av &+ @ D =+ Lv § % weo 2 = my X v s e
Live Data Details (0
. A B c D
Select Columns Benefits Modeling X 0 = B Iy Live Data Details X
2 Darcy Chan Active Employees in Canada Sun Life Medical - Sun Life Basic
3 |Mason Webb Active Employees in Canada Sun Life Medical - Sun Life Basic + Status
(21 search by column name 12 Columns Added Remove All | Preview a sample of dala@ |I ; mmﬂﬂ'ﬁ mgmm:&:: ::'L-: ::::t"w: ::: Report Benefits Modeling
] Ryan Taylor Active Employees in Canada Sun Life Medical - Sun Life Basic Report Type Advanced
B Jamas Mason AmmEmph,ammus - Salaried Blue Cross of Calif. Medical - Blue Cross of Calif. PPO Last Refresh 02/24/2020 at 3:30 PM
All columns have been added Dylan Johnson Active Employees in Canada EE - Employee Only = Global Suj O R~ ma’“’””“"'”‘s"s"w A e L By me (Imcneil)
10 | Catherine Gibson Active Employees in U.S. - Salaried Astna Medical - Aatna PPO Took 6 second(s)
11 | George Haris Active Employees in U.S. - Salaried Astna Medical - Aetna HMO Workbook No Refresh Scheduled
12 |Jennifer Carter Active Employees in U.S. - Salaried Aetna Medical - Astna HMO S?\’dn\D CD e Schadkd ul
13 |Joyee Sandoval Active Employees in U.S. - Salaried Astna Medical - Astna HMO' chedule reate ule
. . 14 | Peter Neumann Active Employees in U.S. - Salaried Astna Medical - Aetna PPO Key Column off
- 15 David Martinaz Active Employees in U S. - Salaried Astna Medical - Aatna PPO
Note: Report columns can be arranged in the editor by . T T —,— et b PP  omtins
. . . . 17 | Juan Deigado Active Employees in U.S. - Salaried Astna Medical - Astna PPO LimitNumberof O
clicking and dragging from the column heading. 10 [Pl Spadng  AcivoEnioyoes nUS.-Salaied Bl ros fCal. Medical B Cross o Cll POS
19 |Michael Yang Active Employees in U.S. - Salaried Blue Cross of Calif. Medical - Blue Cross of Calif. PPO Enable Multi- off
20 |Joel Baker Active Employees in U.S. - Salaried Astna Medical - Aetna PPO Instance Values
i e e it e Hadighine [ Highightve datasea
. 23 |Victor Sabbatini Active Employees in U.S. - Salaried Aetna Medical - Astna PPO Data Area
11. Cllck Next. 24 Laurie Jenkins. Active Employees in Green Planet Solutions Medical - Un PPO
25 | Melissa Hartman Active Employees in U.S. - Salaried Aetna Medical - Astna PPO
26 | Hailey Ward Active Employees in U.S. - Salaried Blue Cross of Calif. Medical - Blue Cross of Calif. HMO
H N . M 4 . 27 |Sara Goldstein mEmmmus - Salaried Astna Medical - Aetna PPO
12. Two import options appear: Live Data or Static Values. Static 7 |nmigoSanchaz  Acive Emplovers 5, Sored B Cross o Gaf. Ml Blo o f Gall.HMD
. X . . L . I P o et A Previous time to refresh
Values import data is effective at import. This import will not be » = — S

linked to live data in Workday.

N\
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MANAGE WORKBOOKS 3. Update the name as necessary.

ORGANIZE WORKBOOKS WITH FOLDERS 4. Click Submit.
1. From Drive, click Add New. DELETE A FILE
2. Select Folder. 1. From Drive, right-click on a file.
2. Select Remove.
5 Uslond Note: A file moved to Trash is not permanently removed.
ploa
[ Folder

RESTORE A FILE

ﬁ': Discovery Board

Workbook 1. From Drive, click the Trash folder from the left-side menu.

2. Restore the file by right-clicking on the file name and selecting
Restore. Or, click Restore in the right pane.

3. Rename the folder and then click OK. Your folder appears on the

N N . N N 1 file is selected Deselect
All Files list. You can now drag files from this page into the folder. - eeates ¢
[ Compensation Spreadsheet Thursday 02/07/2019 2:45 PM ®
COPY A WORKBOOK e omscutremoy @ iofo Friday 01/25/2019 2:59 PM 8 Restore
Ex GMS Culture.mov & Restore Friday 01/25/2019 2:58 PM
Owner
1. From Drive, right-click on an existing workbook. [ v cuture mov Toesdey 01227203 470 P Logan i
IF31  GMS Culture mov. Tuesaai 01/22 %["9!5&?’4 Mocifiad
2. Click Make a Copy.
Drive = Fiters Q Search Drive
Name Owner Access Last Modified 1fileis selocted Deselect
@ Bonus Tracking Te=ss= “arrano People 08/06/2019 [2 Open
[2 open
[ Discovery Boards Only Me 01/06/2020 8, share
8 share
EX GMS Culture.mov Only Me 12/24/2019 &/ Rename
&  Rename
EX GMS Culture.mov Only Me 12/24/2019 B Move
E ™ove
EX GMS Culture.mov Only Me 12/24/2019 V¢ Favorite
T Favorite
B\ GMS Culture.mov Only Me 12/24/2019 @ info
@ o
EX GMS Culture.mov Only Me 12/23/2019
B\ GMS Culture.mov Only Me 12/23/2019 @ Remove
T Remove
EX GMS Culture.mov me Only Me 04/09/2019 Owner
Teresa Serrano
[1 HCM- Total Rewards Modeling Me Only Me 02/11/2019
/\ Your screens and processes may vary from this document. Confidential ©2020 Workday, Inc. 5
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SHARING AND COLLABORATION

There are three permission options for sharing that an owner can
grant to shared users:

Permission Description

Can View Allows view-only permissions to the workbook.

Can Comment | Allows users to view the workbook and post
comments.

Can Edit Allows users to edit, share, and post comments

to the workbook.

You can also set permissions at the folder level. Using permissions
allows you to share multiple files with the same group and set the
necessary permissions only once.

[@] Important: Users need to be enabled in the Worksheets
security domain to share and collaborate.

LINK SHARING

Report owners can now use link sharing and set permissions specific
to that link for added security.

Share My Team's Time Off Balances

Link Sharing @D Permissions  Can View -

/' Can View
https://i- 26 2998526903 htmic Copy Link

Can Comment.

Anyone with this link can access the file with the permissions selected above
Can Edit

Who has access

& Anyone with this link can access the file with the permissions
selected above

Q Logan McNeil Owner
Me

N\

workday. | EDuCATION

Can View

Employee

SHARING AND SETTING PERMISSIONS
GRANT SHARING PERMISSIONS
1. From Drive, select a workbook to share.

2. Right-click on the report and select Share to view the share
workbook options.

Drive = Fihters Q Search Drive
Name Owner Access Last Modified 1 file s selected Desslect
Bonus Tracking ~ Tooees ~arrano People 08/06/2019 [2 Open

[2 open
[ piscovery Boards Only Me 01/06/2020 m
EX GMS Culture.mov Only Me 12/24/2019 y Rename

Z# Rename
EX GMS Culture.mov Only Me 12/24/2019 Move

Move
EX GMS Culture.mov Only Me 12/24/2019 Yr Favorite

Y Favorite
EX GMS Culture.mov ® Only Me 12/24/2019 @ mfo

Info

BN GMS Culture.mov Only Me 12/23/2019 B MakeaCopy

B Makeacopy
EX GMS Culture.mov Only Me 12/23/2019 @ Remove

T Remave
EX GMS Culture.mov me Only Me 04/09/2019 Owner

Teresa Serrana

[ HCM - Total Rewards Modeling Me Only Me 02/11/2019

3. Under Share with Others, add sharing permissions for one or
more individuals you would like to have access. Permissions will
default but can be adjusted.

4. Click OK to save your changes.

Bonus Tracking

e

Name Information Permission

8 Teresa Serrano

& Logan MeNeil

CHANGE INDIVIDUAL SHARING PERMISSIONS
1. Within the workbook that you have shared, click the Share button.

Your screens and processes may vary from this document. Confidential ©2020 Workday, Inc. 6
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orkbool = Share Add Live Data
€ ‘:g rksdbn :ew Format Insert Data Help All changes are saved automatically I—I- Comments x
2. Update sharing permissions using the pull-down menu by each Logan McNeil a few seconds ago
individuals’ name. New Comment

Bonus Tracking

Share Who Has Access

Name Information Permission Add a message... D

8 Teresa Serrano tserrano Owner

8 Logan McNeil Imcneil Can Edit TAG A USER IN A COMM ENT

Can View
Can Comment 1. In a workbook, click the Comments icon.

2. Inthe comments panel, click in the text box to leave a comment.

3. Enter @ and select the username of the individual the comment is

3. Click OK to save your changes. for

Comments X

COMMENTS AND COLLABORATION
VIEW COMMENTS a Logan McNeil a few seconds ago

New Comment

1. From Drive, open a workbook.

Reply

2. Click the Comments icon at the top of the page to view the

comment thread. SHARED WITH

I — p— — - Q Betty Liu (bliu) - Can Comment
REPLY TO A COMMENT ehety >
3. Inthe comments section, click Reply. 4. Click Send icon to add the comment to the thread.
4. This will open the comment feed. Enter your response. REFERENCE WORKBOOK CELLS IN A COMMENT
5. Click Send icon. 1. Select the cell you want to reference a comment to.

/\ Your screens and processes may vary from this document. Confidential ©2020 Workday, Inc. 7
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2. Select Insert > Comment.

3. A Reference link will appear above the comment text box. Fill out
your comment.

. Workbook £, Shared = Share
File Edt View Format Insert Data Help All changes are saved automatically
2 Adal g EL [ 2 HBr ® =+ Lv $§ % wo 2 2 mvy X v sk
® COUNTA 4
6 ()
oy len 3 Comments X
Medical - Sun Life_Basic
m’:‘& m :x Image x m m: : : @ Logan McNeil 3 minutes ago
 Blair White Active Emg Sun Life Medical - Sun Life Basic New Comment
{Ryan Taylor Active Emg  Row Above SunLife Medical - Sun Life Basic Rosly
{Henry Lynch Ao Emg Sun Life Medical - Sun Life Enhanced
| James Mason Active Emg. Blue Cross of Cali. Medical - Blue Cross of Calit. PPO
Jake Lee Active Emg Aetna Medical - Aetna PPO
|Catherine Gibson  Active Emg Column Left Aetna Medical - Aetna PPO
| George Harris. Active Aetna Medical - Aetna HMO
| Jonnifer Carter Active Emg  Column Right Aetna Medical - Aetna HMO
|Joyce Sandoval  Active Emg Aetna Medical - Aetna HMO
|PoterNeumann  Active Emp [ Lo Aetna Medical - Aetna PPO
| David Martinez Active Emp. Astna Medical - Aetna PPO
Barbara Paimer  Active Emg Aetna Medical - Aetna HMO
| Juan Deigado Active Emg  New Sheet Aetna Medical - Aetna PPO
|Philip Spakding Py Blue Cross of Calf. Medical - Blue Cross of Cal. POS
|Michael Yang Active Employoes in U.S. - Salaried Blue Cross of Calif. Medical - Biue Cross of Calil. PPO
 Joel Baker Active Employees In U.S. - Salaried Aetna Medical - Aetna PPO
:Y:_'::_K:Lw :cx E’:;’:”: ': E:: m m m S :,‘o +  @bliu Please review the following cells. >

4. Click Send to add the comment to the thread. Click View
Reference link to show linked cells.

Comments X

g Logan McNeil 4 minutes ago
New Comment

Reply

a Logan McNeil a few seconds ago

@bliu Please review the following cells.

N\
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WORKSHEET RESOURCES

There are three useful resources you can use in worksheets: the
Functions Library, the Functions Reference, and the User Guide.

FUNCTIONS LIBRARY

The Functions Library provides quick access to Workday functions
and identifies the required syntax for the functions. This also includes
a type-ahead feature that assists you as you build your formulas.

In a workbook, click Insert > Function, or click the Function icon.

o Workbook  ashered B she
File Edit View Format Insert Data Help All changes are saved automatically
[ & Adal | 18] Lot Table Br ® =~ L~ § % we 2 2 mv X v Z gl
o m
Lad AN Comment it 3 AZ BA BB BC 8D
1 Functions Library X
Chart

2
: Wrege Q search
5
[ [ rowabove %= TC 4BS
: Raw Below § ACCRINT
° § ACCRINTM
10 Column Left

ACOS
" T
12 Column Right T AcosH
13

AcoT
15 Y aoD
16
7 New Sheet F2 Q ADDRESS
12 § AMORDEGRC

s

The Functions Library panel will open on the right side of the screen.

Your screens and processes may vary from this document. Confidential ©2020 Workday, Inc. 8
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Functions Library X Data Help All changes are saved automatically
Q@ search I User Guide =v i~
TT ABS Function Reference A
+ ACCRINT v Keyboard Shortcuts
Returns the accrued interest for a security that
pays periodic interest.
Category
Financial
Return Type 1
NUMBER . - .
syntax 3. The Worksheets Function Reference opens. Within this document,
ACCRINT(issue, first_interest, settlement, rate, par, you will find a detailed description of the functions, syntax, and
frequency, [besis], [calcmeifiad]) examples of how functions are used and expected results.
issue
The security's issue date. USER GUIDE
first_interest . . . . .
The security’s first interest date, The pser Guide provides information on Workday proprietary
functions and other helpful features.
settlement
The security’ settlement date. The security 1. In aworkbook, click Help to open a menu.
Here, you can search for a function, then reference the formula 2. Select User Guide.
description and syntax.
FUNCTIONS REFERENCE Data Help All changes are saved automatically
The Functions Reference provides detailed formula descriptions, I User Guide = v 1~

syntax, and examples to assist you.
Function Reference

1. In aworkbook, click Help from the workbook menu.
Keyboard Shortcuts

2. Select Functions Reference.

1
The Worksheets User Guide opens.

/-\ Your screens and processes may vary from this document. Confidential ©2020 Workday, Inc. 9
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